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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©June 2009

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.
I



Preface
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
II



Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC 

Output of 19V, 1.58A or 19V, 1.57A (30 Watts) minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD
III



Preface
Instructions for Care and Operation
The computer is rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.
• Do not place it on an unstable surface.
• Do not place anything heavy on the computer

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. 
This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

• Do not expose it to excessive heat.
• Do not leave it in a place where foreign matter or moisture may affect the system.
• Don’t store the computer in a humid environment.

3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted

• Do not turn off the power until you properly shut down all programs.
• Do not turn off any peripheral devices when the computer is on.
• Do not disassemble the computer by yourself.
• Perform routine maintenance on your computer.

5. Take care when using peripheral devices.
• Use only approved brands of peripherals.
• Unplug the power cord before attaching peripheral devices.
IV



Preface
Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifications, 
consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third 
prong is an important safety feature; do not defeat its purpose. If you do not have access 
to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not 
by its wire.

• Make sure the socket and any extension cord(s) you use can support the total current 
load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
V



Preface
Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Pay careful attention to the instructions on swapping the battery.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the computer’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VI



Preface
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
4. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
5. Put the computer in its carrying bag and secure it with the bag’s straps.
6. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
7. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your computer is completely powered off before putting it into a travel bag (or any such container).
VII



Preface
On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the computer - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
VIII



Preface
Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
IX



Preface
Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Schemes to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
X



Preface
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.
XI



Preface
Upgrading the Memory and HDD/SSD
If you want to upgrade your computer by upgrading the system memory or the hard disk drive/solid state drive
you will need to contact your customer service representative. We recommend that you do not do this yourself,
since if it is done incorrectly you may damage the mainboard.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your
warranty.

The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
XII
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk/
Solid State Drive, 5-in-1 card reader, ExpressCard), Audio, Tablet PC Options & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 A quick guide to the computer’s Bluetooth, Wireless LAN, PC Camera, GPS, RFID Reader 

modules (some of which are optional).
• Chapter 7 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Intel Video driver controls.
• Appendix C The computer’s specification.
Overview 1 - 1
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Introduction
This semi-ruggedized tablet computer provides an ideal platform for outdoor computer use with an IP54 (Ingress
Protection) rating against dust and spray and features an optional sunlight readable LCD touch panel; all touch
panels support both finger and stylus pen input. Hard disk drive protection is provided by G-Sensor software that
protects the hard disk drive from a drop of up to 40CM when the system is powered on, and the hard disk drive
is shock mounted offering protection from a drop of 120CM when the system is powered off.

Figure 1 - 1 - Spray Resistant Computer
LED Backlight LCD
The LED Backlight LCDs on this computer model allow for greater color quality and consume less power than
conventional fluorescent LCDs, and therefore can save significant battery life. In addition the LED backlit LCD
allows for clearer reading in sunlit conditions.

Spray Resistant

Note that the computer is spray resistant with a
Ingress protection rating of 4 (i.e protection from
splashed water). Note that spilling liquids directly
on, or immersing the computer in water may vio-
late your warranty.
1 - 2 Introduction
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Optional Accessories
This computer features a range of options including a GPS module (including an optional active aerial), HF
RFID reader, as well as a range of optional accessories including car adapter, charger box, USB to RS 232 cable,
hand holder, shoulder strap and carrying handle.

Figure 1 - 2 - Optional Accessories
Introduction 1 - 3
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Attaching the Optional Hand Holder.
The hand holder offers ease of use when using the computer on the move outdoors. Attach the hand holder as
follows:
1. Place the hand holder at the rear of the computer with the screws facing inwards towards the computer.
2. Align the screws on the hand holder with the screw holes  -  in the rear of the case (you may need to 

adjust the straps to do this).
3. Fully tighten the screws  -  using a flathead screwdriver.
4. Put your hand through the hand holder and secure it with the velcro straps  & .

Figure 1 - 3 - Attaching the Optional Hand Holder
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1 and “BIOS Utilities” on page 5 - 1 in the reminder of the User’s
Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
Introduction 1 - 5
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Not Included
Operating Systems (e.g. Windows Vista or XP) and applications (e.g. word processing, spreadsheet and database
programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1 (you will need an external USB optical device drive). Drivers are
programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It
is very important that you install the drivers in the order listed in. You will be unable to use most advanced controls until
the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service rep-
resentative may have already done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 1 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.
1 - 6 Introduction
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported.

Table 1 - 1 - Operating Systems Supported

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Win-
dows XP Information” on page D - 1.

Operating System & Version Note

*Windows XP - SP3 (32-bit) Home or 
Professional

In order to run Windows XP without limitations or
decreased performance, your computer requires a
minimum 512MB of system memory (RAM)

Windows Vista - SP1 (32-bit) 
Home Basic Edition

In order to run Windows Vista without limitations or
decreased performance, your computer requires a
minimum 1GB of system memory (RAM).

Windows Vista Service Pack 1

Make sure you install Windows Vista Service Pack 1 (or a Windows Vista version which includes Service Pack 1) before
installing any drivers. Go to the Microsoft website for download details, or contact your service center.
Introduction 1 - 7
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System Startup
1. Remove all packing materials.
2. Place the computer flat on a stable surface with LCD panel facing upwards.

Figure 1 - 4 - Computer with AC/DC Adapter Plugged-In / Computer with Stylus Pen
3. Securely attach any peripherals you want to use with the computer (e.g. keyboard or mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Press the power button to turn the computer “on”.
6. Remove the Stylus pen to use as your input device.
7. The LED indicators show the power and battery status of the computer.

Shutdown

Please note that you should always shut
your computer down by choosing the Turn
Off Computer command from the Start
menu in Windows. This will help prevent
hard disk or system problems.

External Optical (CD/DVD) Device Drives

To install applications and drivers etc. you
will need to attach an external optical CD/
DVD device to the USB ports.

Touch Panel Input 
Device

Do not use any sharp or point-
ed objects as your input de-
vice e.g. the end of a pen or
pencil. You should only use
the provided stylus pen (PDA
type) as your input device. Be
very careful not to press too
hard with the stylus pen when
using it as the input device. 
1 - 8 System Startup
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Operating System Setup
If you are installing new system software, or are re-configuring your computer for a different system, make sure you
configure the appropriate OS setting in the BIOS before installing a new operating system.

1. Start-up the computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select “Installed O/S” and make sure the appropriate operating system is selected.
3. Go to the Exit menu and select “Exit Saving Changes” (or press F10 and select “Yes” then press Enter) and 

press Enter to exit the BIOS and reboot the computer.

Figure 1 - 5 - Advanced BIOS Menu

Main AAdvanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select the operating

system installed on

your system which you

will use most

commonly.

Note: An incorrect

setting can cause

some operating

systems to display

unexpected behavior.

Phoenix SecureCore(tm) Setup Utility

Installed O/S: [WinXP/Vista]

Reset Configuration Data: [No]

Boot-time Diagnostic Screen: [Disabled]

POST Boot Sound [Disabled]

Battery Low Alarm Beep: [Disabled]

Hyperthreading: [Enabled]
Operating System Setup 1 - 9
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System Software Installation
Your computer may come with an operating system software and all necessary drivers pre-installed. If you are
installing new system software, or are re-configuring your computer for a different system, you will need to in-
stall the drivers after installing the operating system.

Operating System Installation
Prepare the following before installing the Microsoft Windows Vista Home Basic Edition - 32-bit (with Service
Pack 1) or Microsoft Windows XP - 32-bit (with Service pack 3) operating system software:
• An external USB CD/DVD device drive (the Microsoft Windows OS CD should be inserted into this drive).
• The Device Drivers & Utilities + User’s Manual Disc.
• A USB keyboard connected to one of the USB ports.
4. Attach the external USB CD/DVD device drive (containing the Microsoft Windows OS CD) to the computer.
5. Start-up your computer and press <F2> to enter the BIOS.
6. Go to the Boot menu (see “Boot Menu” on page 5 - 13).
7. Set the external CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first 

device in the boot order from the Boot priority order menu (use the “+” and “-” keys to move the device up and 
down the priority order.

8. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and 
reboot the computer.

9. As the computer starts up, press a key when you see the message "Press any key to boot from CD".
10. The system software will prompt you through the installation procedure (see the Microsoft Windows OS 

documentation for more details).
11. Install the drivers as per the instructions in Chapter 4 (in the order indicated in Table 4 - 1, on page 4 - 3).
1 - 10 Operating System Setup
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Tablet Notebook Input
Use the stylus pen provided to interact with the computer in the same way you would use the mouse (tap twice
to double-click and keep the pen in contact with the screen to right-click). Before using the stylus pen you should
calibrate the touch screen.

Calibrating the Touch Panel
1. Double-click the Touch tool utility icon  on the desktop OR from the Touch Package folder in the Pro-

grams/All Programs group (the driver must be installed).
2. Click General.
3. Click 9 pts Linearity (if you would prefer to calibrate more accurately, or are having distortion/tracking 

problems, then click Advance and choose either 25 pts Linearity).

Figure  1 - 6 - Touch Package (General & Advance)
Tablet Notebook Input 1 - 11
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4. Use the stylus pen to touch the blinking symbol until symbol changes color (maintain contact until the symbol stops blinking) 

and you will be prompted to lift up the pen.
5. Repeat the process for all the remaining screen points.
6. Click Free Draw (button) to test the calibration.
7. Use the Mouse Emulation and Sound control panels to further adjust the settings to your preference.

Figure  1 - 7 - Screen Calibration

Touch Panel Input 
Device

Do not use any sharp or
pointed objects as your
input device e.g. the end
of a pen or pencil. You
should only use the pro-
vided stylus pen (PDA
type) as your input de-
vice. Be very careful not
to press too hard with the
stylus pen when using it
as the input device. 

Screen Distortion

If you experience any line
distortion, or tracking in-
accuracy, recalibrate the
touch screen using 25pts
of calibration (click the
Advance item in the
Touch package and
click 25pts Linearity).
1 - 12 Tablet Notebook Input
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Pen Options & Tablet Settings
Configure the stylus pen input settings, from the Pen and Input Devices control pane in Windows Vista; the
Tablet PC Settings control panel allows you to configure the tablet screen appearance. Access the control panels
as follows:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mobile PC and click Pen and Input Devices (or just double-click Pen and Input Devices).
3. Click Mobile PC and click Tablet PC Settings (or just double-click Tablet PC Settings).

Figure 1 - 8 - Pen and Input Devices & Tablet PC Settings Control Panel

Tablet PC Options

See “Tablet PC Options”
on page 2 - 10 for further
information on Tablet PC
settings etc.
Tablet Notebook Input 1 - 13
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On-Screen Keyboard
The On-Screen Keyboard allows you to input text without the use of a keyboard. Move the pen over any char-
acter and then tap it to activate it.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Ease of Access and click Start On-Screen Keyboard.
3. Use the stylus pen to tap the appropriate keys to input.
4. Click the Help menu to get more information.

Figure 1 - 9 - On-Screen Keyboard

Note: You can use the Ease of Access icon  at system startup (at the point of system password entry) to bring
up the On-Screen Keyboard and input the system password.
1 - 14 Tablet Notebook Input
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System Map: LCD Panel View - Front

Figure 1 - 10
LCD Panel View - Front

1. Built-In Microphone
2. LED Indicators
3. LCD Touch Panel 

Screen
4. Speakers
5. Fingerprint Reader
6. 5 Function Buttons
7. Protective 

Surround

2

2
1

7

4

6

3

5
4

7

System Map: LCD Panel View - Front 1 - 15
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LED Indicators
The LED indicators on the computer display helpful information about the current status of the computer.

Table 1 - 2 - LED Indicators

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached Critically Low Power Status

Green Hard Disk / System Activity
1 - 16 System Map: LCD Panel View - Front
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Function Buttons
The function buttons provide easier access to functions on the computer.

Table 1 - 3 - Function Buttons

Press the Camera Button  to run the BisonCap application program (for PC Camera). When the BisonCap
application program is running, press the Camera Button  to take a still picture. 

Use the Zoom Mode  (press the Mode Toggle  Button to toggle Zoom and Page Modes) to zoom in and
out of open picture files (e.g. bitmap, jpeg files etc.). 

Use the Page Mode  to Page Up  and Page Down  text files etc.

Key Buttons Icon Description

Page Mode  / Zoom Mode  Toggle

Access / Hide the On-Screen Menu

Page Mode = Page Up / Page Down
Zoom Mode (for Picture files - Does NOT Zoom the Camera) = 

Zoom In / Zoom Out

Run the BisonCap Application
If the BisonCap Application is Running = Take Still Picture
System Map: LCD Panel View - Front 1 - 17
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On-Screen Menu
Pressing the Menu button (or double-click the Pop Menu icon  in the taskbar) on the computer will bring up
the on-screen menu (make sure you install the pop menu driver - see “Pop Menu Utility” on page 4 - 6). Use
the stylus pen to touch any of the buttons to activate the control. Press the Menu button (or double-click the Pop
Menu icon  in the taskbar) to quit the menu. Use the stylus pen to tap the appropriate on-screen button to
adjust the setting and the button will display the current status.

Figure 1 - 11 - On-Screen Menu

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard air-
craft is usually prohibited. Make
sure the module(s) are OFF if you
are using the computer aboard air-
craft.

Use the On-Screen Menu button
to toggle power to any Wireless/
Bluetooth/GPS module, and check
the menu icon to see if the module
is powered on or not.
1 - 18 On-Screen Menu
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Table 1 - 4 - On-Screen Menu Buttons

Function On-Screen Button Function On-Screen Button

Brightness 
Decrease/Increase

Bluetooth Module 
Power Toggle

Volume Decrease/
Increase

PC Camera Module 
Power Toggle

Mute Toggle
G-Sensor 

Protection Mode 
Toggle

Display Toggle GPS Module Power 
Toggle

Display Battery 
Level

RFID Module 
Power Toggle

WLAN Module 
Power Toggle

Note: Any modules not included in your purchase configuration will appear grayed out when the key combination is pressed.

Note: Use the stylus pen to tap the appropriate on-screen button to adjust the setting.

Note: The default setting for the Wireless LAN and PC Camera modules is OFF.
On-Screen Menu 1 - 19
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G-Sensor - Hard Disk Drive Protection
The built-in G-Sensor gives protection to the system and hard disk (the G-Sensor does not function with Solid
State Drives) in the event that the computer is accidentally dropped when the system is powered on (40cm drop
approved when the system is powered on and 120cm drop approved when the system is powered off). Press
the Menu button (or double-click the Pop Menu icon  in the taskbar) to bring up the on-screen menu and use
the stylus pen to toggle the G-Sensor mode ON  or Off . 

If the system is dropped, and the G-Sensor is on, the system will briefly pause (for about 3 seconds) to protect
the hard disk and will display an on-screen message and an audible warning) to inform that the hard disk is pro-
tected. Allow the system about 3 seconds to recover before using it again.

Figure 1 - 12 - HDD Protected Message
Set the G-Sensor On or Off in accordance with the manner the computer is being used. If the computer is sitting
on the desktop (or if you find the G-Sensor is too sensitive), then the G-Sensor can be turned Off. The G-Sensor
will be automatically activated to offer protection when the computer enters Sleep or Hibernate modes (even if
turned off).
1 - 20 G-Sensor - Hard Disk Drive Protection
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System Map: Rear View Figure 1 - 13

LCD Rear View - 

1. Built-In PC Camera 
2. GPS Active Aerial 

Socket (for 
optional Active 
Aerial)

3. Protective 
Surround

4. Stylus Pen & 
Holder

5. Battery Gauge
6. Battery

Battery Information

See “Battery Informa-
tion” on page 3 - 9 for full
instructions.

1

3

6
5

3

4

2
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System Map: Left View

Figure 1 - 14
Left View

1. Security Lock Slot
2. Stylus Pen & 

Holder
3. DC-In Jack
4. 1 * USB 2.0 Port

Mouse & Keyboard

You can use any external
mouse and keyboard at-
tached to any of the USB
ports.

2
41 3

43

Touch Panel Input Device

Do not use any sharp or pointed objects as your input de-
vice e.g. the end of a pen or pencil. You should only use
the provided stylus pen (PDA type) as your input device.
Be very careful not to press too hard with the stylus pen
when using it as the input device. 

1
2

External Optical (CD/
DVD) Device Drives

To install applications
and drivers etc. you will
need to attach an ex-
ternal optical CD/DVD
device to the USB
ports.
1 - 22 System Map: Left View
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System Map: Right View Figure 1 - 15

Right View

1. Headphone-Out 
Jack

2. External Monitor 
Port

3. Card Reader 
Cover

4. ExpressCard 34 
Slot (see below)

5. 5-in-1 Card 
Reader

ExpressCard Support

There is a list of approved
ExpressCard modules listed
on Table E - 1, on page E -
1 Please make sure any Ex-
pressCards modules you
use with this computer are
included in the list. Contact
your service center for fur-
ther information.

2

5

4

1 3

5-in-1 Card Reader

The card reader allows you to use the most popular digital storage card 
formats:

SD (Secure Digital)
Mini SD (requires PC adapter)
SDIO (requires PC adapter)

MMC (MultiMedia Card)
RS MMC (requires PC adapter)

1 2
System Map: Right View 1 - 23
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System Map: Top & Bottom Views

Figure 1 - 16
Top & Rear Views

1. Strap Holders (for 
Carrying Strap) 

2. Power Button
3. RFID (Radio 

Frequency 
Identification) 
Reader (Factory 
Option)

4. RJ-45 LAN Jack
5. 1 * USB 2.0 Ports

2 3

54

1 1

External Optical (CD/DVD) Device Drives

To install applications and drivers etc.
you will need to attach an external optical
CD/DVD device to the USB ports.
1 - 24 System Map: Top & Bottom Views



Quick Start Guide 1

Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers pro-
vided. To see all controls it may be necessary to toggle to Classic View on.

Figure  1 - 17 - Start Menu & Control Panel

Click here to toggle Classic View 
Windows Vista Start Menu & Control Panel 1 - 25
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Video Features
You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista as long as the appropriate Intel video driver is installed.

To access Display Settings in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > 

Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 18 on page 1 - 27).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 18 on page 1 - 27).
5. Click Advanced Settings (button)  (Figure 1 - 18 on page 1 - 27) and click Intel(R) GMA Driver for ultra mobile (tab).
6. Click Graphics Properties (button)  (Figure 1 - 18 on page 1 - 27) to access the Intel GMA Driver for ultra mobile 

control panel (this control panel can also be accessed by double-clicking Intel(R) GMA Driver for ultra mobile control panel 
in Windows Classic View).

7. The Intel GMA control panel can also be accessed by clicking the icon  in the taskbar and selecting Graphics Properties 
from the menu.

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display
connected to the external monitor port as your display device. Note: MID (Mobile Internet Device) is the com-
puter’s LCD display.

1
2

3
4

1 - 26 Video Features
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Figure  1 - 18 - Display Properties Desktop

Table 1 - 5 - Display Options

Intel Display Mode Description

Single Mode One of the connected displays is used as the display device

Intel(R) Dual Display Clone Mode Both connected displays output the same view and may be configured independently

Extended Desktop Mode Both connected displays are treated as separate devices, and act as a virtual desktop

1 2

3

4
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 25) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, display and sleep mode from the left menu. Note
that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Figure  1 - 19 - Power Options

Note: Sleep is the default power saving state in Windows Vista
1 - 28 Power Options
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Optimizing Battery Life
To optimize your battery life, follow the instructions below and also see “Conserving Battery Power” on page 3
- 10. You can check the battery’s current capacity from the gauge at the rear of the computer (see “Battery
Gauge” on page 3 - 16).

Set the Power Plan to Power saver:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Power Options (icon); Power Options (icon) is in the System and Maintenance category.
3. Click Power saver (button) in select Select a power plan.
4. Close the control panel.

Power Off any modules not in use:
1. Press the Menu button (or double-click the Pop Menu icon  in the taskbar).
2. Use the stylus pen to touch any of the buttons to turn off any module not in current use (e.g. camera, Bluetooth, 

WLAN etc.).

Figure 1 - 20 - Power Saver Power Plan
Power Options 1 - 29
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Removing the Battery
If you need to remove the battery follow the procedure below.
1. Turn the computer off (unless you are hot swapping the battery), and turn it over.
2. Remove screws at points  - .
3. Remove the battery cover . 
4. Grip the tab  and lift the battery out in the direction of the arrow .

Figure 1 - 21 - Battery Removal

1 4
5

6 7

6

1

7

2 3

4

5

1 - 30 Removing the Battery
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Hot-Swapping the Battery
If you have more than one battery included in your purchase option you can swap the battery while the system
is running. 

1. Check the level of the backup battery from the on-screen menu.
2. Press the battery level button  to display the indicator:

Figure 1 - 22 - Battery Level Indicator
3. The lower indicator will display the bridge battery level and the upper indicator displays the main battery level.
4. If the bridge battery level indicated “Ready” you can swap batteries.
5. Remove the AC/DC adapter cable from the DC-In jack (if applicable) and an on-screen icon will indicate the 

main battery status if less than a 3% charge remains.

Figure 1 - 23 - Bridge Battery Ready Indicators
6. You can then remove the battery as per the instructions in “Removing the Battery” on page 1 - 30.
7. When the battery is removed a beep will indicate that the system is running on bridge battery power (you have 

up to 3 minutes maximum to swap the battery depending upon applications being used).
8. When a new sufficiently charged battery is inserted the beep will stop.

Main Battery Level

Bridge Battery Level

Battery Less than 3% Charge - Plug-in Adapter to ChargeBattery Less than 3% Charge - Change Battery
Hot-Swapping the Battery 1 - 31
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Chapter 2: Features & Components
Overview
Read this chapter to learn more about the following main features and components
of the computer.

• Hard Disk Drive/Solid State Drive
• 5-in-1 Card Reader
• ExpressCard Slot
• Audio Features
• Tablet PC Options
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive/Solid State Drive
The hard disk drive or solid state drive (factory options) is used to store your data
in the computer. The HDD/SSD can be taken out (please check with your service
representative before undertaking any upgrade or replacement procedures to find out
if this will VOID your warranty) to accommodate other 2.5" serial (SATA) HDDs/
SSDs (SLC) with a height of 9.5 mm.

The built-in G-Sensor gives protection to the system and hard disk (the G-Sensor
does not function with Solid State Drives) in the event that the computer is acciden-
tally dropped when the system is powered on (40cm drop approved when the sys-
tem is powered on and 120cm drop approved when the system is powered off).
Press the Menu button (or double-click the Pop Menu icon  in the taskbar) to
bring up the on-screen menu and use the stylus pen to toggle the G-Sensor mode ON

 or Off . See “G-Sensor - Hard Disk Drive Protection” on page 1 - 20
for more details.

Upgrading the 
HDD/SSD

If you want to upgrade
your computer by up-
grading the hard disk
drive/solid state drive
you will need to contact
your customer service
representative. We rec-
ommend that you do not
do this yourself, since if
it is done incorrectly you
may damage the com-
puter.
2 - 2 Hard Disk Drive/Solid State Drive
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5-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep
card reader cover
closed when not in use.
This will help prevent
foreign objects and/or
dust getting in to the
card reader.

 Figure 2 - 1
Right View

1. Card Reader 
Cover

2. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)

• Mini SD (requires PC adapter*)
• SDIO (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

2

5-in-1 Card Reader 2 - 3
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 ExpressCard Slot
The computer is equipped with an ExpressCard 34 slot. ExpressCards are the suc-
cessors to PCMCIA (PC Cards). Make sure you install the Card Reader driver

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it.

ExpressCard 
Slot Cover

Make sure you keep
card reader cover
closed when not in use.
This will help prevent
foreign objects and/or
dust getting in to the
card reader.

 Figure 2 - 2
Right View

1. Card Reader 
Cover

2. ExpressCard 
Slot

1

2

ExpressCard 
Support

There is a list of approved
ExpressCard modules
listed on Table E - 1, on
page E - 1 Please make
sure any ExpressCards
modules you use with this
computer are included in
the list. Contact your ser-
vice center for further in-
formation.
2 - 4 ExpressCard Slot
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may be adjusted by means of the On-Screen Menu buttons or the volume icon in
the taskbar (see sidebar). 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 3
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
Audio Features 2 - 5



Features & Components

2
 Tablet PC Options
Chapter 1 contains basic information on calibration (see “Calibrating the Touch
Panel” on page 1 - 11), pen options and tablet settings (see “Pen Options & Tablet
Settings” on page 1 - 13) and the On-Screen keyboard (see “On-Screen Keyboard”
on page 1 - 14). The following pages will add some more detailed information on
Tablet PC input and settings.
2 - 6 Tablet PC Options
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Screen Orientation
If you prefer to orientate the screen differently follow these steps.

Screen Orientation - Windows Control Panel
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Click Mobile PC (or just double-click Tablet PC Settings) and then click Tablet 

PC Settings.
3. Click Display (tab) and select the orientation required.
4. Click Apply.
5. It is advisable to calibrate the touch panel after rotating the screen (see page 1 - 11).

 Figure 2 - 4
Tablet PC Settings 

(Display)
Tablet PC Options 2 - 7
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Screen Orientation - Intel GMA Control Panel
1. Open the Display Settings control panel (see “Video Features” on page 1 - 26) 

and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).
3. Go to the Intel GMA control panel (see “Video Features” on page 1 - 26) and

click Display Settings.
4. Make sure Enable Rotation is ticked and choose the degree of rotation.
5. Click Apply and OK to confirm the setting change.
6. It is advisable to calibrate the touch panel after rotating the screen (see page 1 -

11).

 Figure 2 - 5
Intel GMA Display 
Settings (Rotation)
2 - 8 Tablet PC Options
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Touch Package Settings
You can also configure the pen options from the Touch Package control panel.

1. Double-click the Touch tool utility icon  on the desktop OR from the Touch 
Package folder in the Programs/All Programs group (the driver must be 
installed).

2. Click Mouse Emulation.
3. Double-click either Drawing Mode or Button Mode to configure the Right-Click 

or Double-Click settings (you can also disable touch altogether if you prefer).

Other Tools

The Touch Package
Touch Tool utility also
allows you to configure
Sound options (for
when you touch and lift
up the stylus pen) and
gives you quick access
to system information
(Advance > System In-
formation Tool).

 Figure 2 - 6
Touch Package 

Mouse Emulation
Tablet PC Options 2 - 9
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Pen and Input Devices
You can configure the pen options from the Pen and Input Devices control panel.

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Click Mobile PC (or just double-click Pen and Input Devices) and then click Pen 
and Input Devices.

3. Select the Pen action from the left menu and click Settings to configure the 
setting.

4. You can select the sensitivity of the double-tap speed and distance, the sensitivity 
and duration of press and hold (for right-clicking), and you can test the settings 
from this menu.

 Figure 2 - 7
Double Tap & Press 
and Hold Settings
2 - 10 Tablet PC Options
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Other Useful Windows Vista Features for Tablet PC Users

Multi-Select Files in Windows Explorer
The option to multi-select files in Windows Explorer in Windows Vista is very
useful when using a pen as your input device.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Appearance and Personalization and click Folder Options  (or just 

double-click Folder Options).
3. Click View (tab), and make sure Use check boxes to select items is ticked.
4. Click OK to save the setting.
5. Check boxes will appear in open folders to allow you to easily multi-select files with 

a pen.

 Figure 2 - 8
Folder Options

&
Multi-Select Files
Tablet PC Options 2 - 11
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 Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
2 - 12 Adding a Printer
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

Hibernate Mode In 
Windows Vista SP1

If you are using Win-
dows Vista SP1 with
4GB RAM installed, see
page 7 - 10 for informa-
tion on Hibernate.
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Press the power button and then release it to turn the computer “on”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).
3 - 2 The Power Sources



Power Management

3

Turning on the Computer
Now you are ready to begin using your computer. To turn it on press the power but-
ton and release it.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-
key button when you press and release it in less than 4 seconds (pressing the power
button without releasing it for longer than this will force the computer to shut down).
Use Power Options (Hardware and Sound menu) control panel in Windows Vista
to configure this feature.

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination on an attached keyboard
doesn’t work, press and hold the power button for 4 seconds, or longer, to force the system
to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed and released in less
than 4 seconds. You may configure the options for the power button from the Power Op-
tions (Hardware and Sound menu) control panel in Windows Vista (see your OS’s doc-
umentation, or “Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan - 

Advanced Settings
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Intel GMA Driver 
Power Settings

Use the Power Set-
tings control to allow
the Intel(R) GMA Driver
for ultra mobile control
panel to adjust the pow-
er options when the
computer is running on
battery power (see
“Power Settings” on
page B - 5).

Figure 3 - 2
Power Plans

Video Files

If you are playing vid-
eo files (e.g. mpeg
files) on the comput-
er, it is recommended
that you choose the
High Performance
power plan. 
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

Power Button

The Power Button  in
the Start Menu (in Clas-
sic View use the Shut
Down button ) can be
used to send the com-
puter into a power-sav-
ing state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 3
Lock Button menu
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power button, sleep button (on any attached keyboard) or Sleep command from
the Lock Button Menu in Windows Vista may be set to send the computer in to a
power-saving state.

Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button on an attached keyboard.

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button on any attached 
keyboard

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Move any attached Mouse//Touch the Screen

Table 3 - 1
Resuming 
Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed and released in less than 4 seconds (pressing the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 9
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
3 - 10 Battery Information
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth or communication applications when they are not 
being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used etc.

Figure 3 - 6
Windows Mobility 

Center
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 1 - 30.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 16 for information on the battery charge status, and to “Battery
Information” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)
3 - 12 Battery Information



Power Management

3

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
Battery Information 3 - 13
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan - Create
3 - 14 Battery Information
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears).

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
Battery Information 3 - 15
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

Battery Gauge
The battery gauge at the rear of the computer provides a clear indication of remain-
ing battery life. Firmly press the PUSH CHECK button and the Led will show the
current battery level.

Figure 3 - 9
Battery Capacity 

Gauge
3 - 16 Battery Information
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Battery Indicators
On-screen indicators will display the battery status if the battery level button

 is pressed or the AC/DC adapter is not connected.

Action Icon Description

The on-screen 
battery level  
button is pressed.

Main Battery Level Indicator

Bridge Battery Level Indicator

AC/DC Adapter 
Connection 
Removed

Main Battery Level is Under 3%
Plug-in the AC/DC Adapter

Main Battery Level is Under 3%
Change Battery

Table 3 - 1
On-Screen Battery 

Indicators
Battery Information 3 - 17
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities. 

Note: For Windows XP driver installation information
see “Driver Installation” on page D - 32.

What to Install
You will need to attach a CD/DVD drive to the com-
puter in order to access the drivers on the Device Driv-
ers & Utilities + User’s Manual disc. This contains
the drivers and utilities necessary for the proper oper-
ation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated.

Module Driver Installation
The procedures for installing drivers for the Wireless
LAN, PC Camera and Fingerprint modules are pro-
vided in “Modules” on page 6 - 1.

Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 6 - 2
for configuration instructions.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Manual Driver Installation
Click Browse CD (button) in the Drivers Installer ap-
plication and browse to the executable file in the ap-
propriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
6 for instructions.

Vista (SP1) Driver Page #

Chipset Page 4 - 5

Video Page 4 - 5

LAN Page 4 - 5

Touch Panel Application Page 4 - 6

Pop Menu Utility Page 4 - 6

Audio Page 4 - 6

Wireless LAN Module Page 6 - 6

PC Camera Module Page 6 - 11

Fingerprint Reader Module Page 6 - 17
Windows Vista Service Pack 1

Make sure you install Windows Vista Service Pack 1
(or a Windows Vista version which includes Service
Pack 1) before installing any drivers. Go to the Micro-
soft website for download details, or contact your service
center.
Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the
driver install procedure), click Cancel to close the
window, and follow the installation procedure.
4 - 4 Driver Installation
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc into your attached CD/DVD drive and click In-
stall Drivers (button), or Option Drivers (button) to
access the optional driver menu.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Driver Installation General Guidelines

The driver installation procedure outlined in this Chap-
ter (and in Chapter 7 Options & Modules), are accu-
rate at the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.
Driver Installation 4 - 5
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Touch Panel Application
1. Click 4.Install Touch Panel Driver > Yes.
2. Click Next > Next > Install.
3. Click Finish.
4. Click OK to restart the computer.
5. You will then need to calibrate the touch panel 

(see “Calibrating the Touch Panel” on page 1 
- 11).

Pop Menu Utility
1. Click 5.Install POP Menu Utility > Yes. 
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
4. See “On-Screen Menu” on page 1 - 18 for 

details.

Audio
1. Click 6.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point 
to Settings and click Control Panel).

2. Click Check for updates (Security), or 
double-click Security Center and click 
Windows Update.

3. Double-click Check for updates (button).
4. The computer will now check for updates 

(you need to be connected to the internet).
5. Click Install now (button) to install the 

updates.
4 - 6 Driver Installation
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Optional Drivers
See the pages indicated overleaf for the driver installa-
tion procedures for any modules included in your pur-
chase option.

Figure 4 - 3 - Optional Drivers

Bluetooth Module
Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 6 - 2
for configuration instructions.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 6 - 6, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on
page 6 - 11, and check the installation procedure.

Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module”
on page 6 - 17, and check the installation procedure.
Driver Installation 4 - 7
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
Note that you will need to attach a USB keyboard to one of the USB ports in
order to edit the BIOS settings.

If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen
(see page 5 - 9), the
POST screen will not ap-
pear.

Figure 5 - 1
POST Screen

Phoenix TrustedCore(tm) NB

Copyright 1985-2006 Phoenix Technologies Ltd.

All Rights Reserved

Bios Revision: ********

KBC/EC Firmware Revision: ********

CPU = 1 Processors Detected

Intel(R) Atom(TM) CPU Z250 @ 1.33GHz

1015M System RAM Passed

512KB L2 Cache

System BIOS shadowed

Video BIOS shadowed

Fixed Disk 0: TOSHIBA MK1246GSX

Mouse intialized

Press <F2> to enter SETUP

1

2
3

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Note that you will need to attach a USB keyboard to one of the USB ports in
order to edit the BIOS settings.

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Program
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Program 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or

<Enter> selects field.

Main

System Time: [22:12:05]

System Date: [04/24/2009]

Large Disk Access Mode: [DOS]

� Primary Master [TOSHIBA MK1246GSX-(P]

� Primary Slave [None]

System Memory 640 KB

Extended Memory 1014 MB

BIOS Revision ********

KBC/EC Firmware Revision ********

Phoenix SecureCore(tm) Setup Utility
5 - 6 Main Menu
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Large Disk Access Mode (Main Menu)
This refers to the representation of hard disk drive geometries as addressed by dif-
ferent operating systems. Select “Other” if you are using systems such as Novell,
UNIX etc. Select “DOS” (default) if you are using Windows.

Primary Master/ Primary Slave (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a HDD/optical de-
vice on the computer’s Primary Master/Primary Slave channels is applicable. Use
the Auto (Type:) setting to have the items configured automatically for you.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.
Main Menu 5 - 7
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Advanced Menu

Installed O/S (Advanced Menu)
This setting tells the computer what kind of operating system you’re using. Make
sure you choose the correct setting for your O/S in order to prevent system problems. 

Figure 5 - 3
Advanced Menu Main AAdvanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select the operating

system installed on

your system which you

will use most

commonly.

Note: An incorrect

setting can cause

some operating

systems to display

unexpected behavior.

Phoenix SecureCore(tm) Setup Utility

Installed O/S: [WinXP/Vista]

Reset Configuration Data: [No]

Boot-time Diagnostic Screen: [Disabled]

POST Boot Sound [Disabled]

Battery Low Alarm Beep: [Disabled]

Hyperthreading: [Enabled]
5 - 8 Advanced Menu
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Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (see Figure
5 - 1 on page 5 - 2).

POST Beep Sound (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Hyperthreading (Advanced Menu)
Hyperthreading will increase performance of your computer, depending on the hard-
ware and software you use, by activating additional CPU threads. Make sure your
OS supports Hyperthreading if you are installing a non-Windows OS. 
Advanced Menu 5 - 9
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the PhoenixBIOS Setup Utility. This will not
affect access to the computer OS, (only the PhoenixBIOS Setup Utility).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu

Main Advanced SSeeccuurriittyy Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password

controls access to the

setup utility.

Security
=

Supervisor Password Is: Clear

User Password Is: Clear

Set Supervisor Password [Enter]

Set User Password [Enter]

Diskette access: [Supervisor]

Virus check reminder: [Disabled]

System backup reminder: [Disabled]

Password on boot: [Disabled]

Phoenix SecureCore(tm) Setup Utility
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Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup
Utility. This will not affect access to the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu items in the Phoenix
SecureCore Setup Utility cannot be modified in user mode. You can only set the
user password after you have set the supervisor password.

Diskette access (Security Menu)
If you have set Supervisor and User passwords, you can set the level of access to
any attached diskettes here.

Virus check reminder (Security Menu)
You can set a virus check reminder here to be enabled at system boot. The reminder
can be set to be given Daily, Weekly (every Monday), or Monthly (on the 1st day of
the month).
Security Menu 5 - 11
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System backup reminder (Security Menu)
You can set a system backup reminder here to be enabled at system boot. The re-
minder can be set to be given Daily, Weekly (every Monday), or Monthly (on the
1st day of the month).

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 5
Boot Menu

Phoenix SecureCore(tm) Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or

configure devices:

Up and Down arrows

select a device.

<+> and <-> moves

the device up or down.

<x> exclude or include

the device to boot.

<Shift + 1> enables or

disables a device.

<1 - 4> loads default

boot sequence.

Boot priority order:
1: IDE FDC:
2: USB CDROM:
3: USB KEY:
4: USB HDD:
5: PCI SCSI:
6: IDE CD:
7: IDE HDD: TOSHIBA MK1246GSX-(PM)
8: PCI BEV: Realtek Boot Agent

Excluded from boot order:
: USB ZIP:
: USB LS120:
: Other USB:
: 1394 CDROM:

Main Advanced Security Boot Exit
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu

Phoenix TrustedCore(tm) Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Execute Command F10 Save and Exit

Item Specific Help

Exit System Setup and

save your changes to

CMOS.

Exit Saving Changes �

Exit Discarding Changes

Load Setup Defaults

Discard Changes

Save Changes

Main Advanced Security Boot Exit
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Chapter 6: Modules
Overview
This chapter contains information on the following modules, which come with your
computer, depending on the configuration purchased. If you are unsure please con-
tact your service representative.

• Bluetooth Module (Factory Option)
• Wireless LAN Module
• PC Camera Module
• Fingerprint Reader Module
• GPS Module
• RFID Reader Module

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft. 
Overview 6 - 1
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Bluetooth Module
The operating system’s Bluetooth Devices (the Bluetooth module is a Factory Op-
tion) control panel is used to configure the Bluetooth settings in Windows Vista, and
therefore does not require a driver. Use the On-Screen Menu button  to power
ON the Bluetooth module (see “On-Screen Menu” on page 1 - 18).
.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the On-Screen Menu
button to toggle power to
the Bluetooth module, and
check the menu icon to see
if the module is powered on
or not (see Table 1 - 4, on
page 1 - 19).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the On-Screen Menu button to power on the Bluetooth module after the comput-
er resumes from Sleep.
6 - 2 Bluetooth Module
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the On-Screen Menu button to toggle power to the Bluetooth module.
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then 

click Bluetooth Devices (Hardware and Sound).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth Devices
control panel. Click Op-
tions (tab), and make
sure that Show Blue-
tooth icon in the notifi-
cation area check box
(Connections) has a
tick inside it.

Note that you will need
to check the LED indica-
tor to see if the module
is powered on or not.

Figure 6 - 1
Bluetooth Devices & 

Click Icon Menu
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
4. The Add Bluetooth Device Wizard will appear.
5. Click to select “My device is set up and ready to be found”, and then click Next.

6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.

9. Click Finish.

Passkey Options

You can allow the sys-
tem to choose a pass-
key for you. You will
then be prompted to en-
ter the generated pass-
key on your Bluetooth
device.

Figure 6 - 2
Add Bluetooth 
Device Wizard

Figure 6 - 3
Passkey Option
6 - 4 Bluetooth Module
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box 

(Connections) has a tick inside it, if you want to be notified when a Bluetooth 
device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box,
and select an item from
the returned search re-
sults to get more infor-
mation.

Figure 6 - 4
Bluetooth Devices 

Options
Bluetooth Module 6 - 5



Modules

6

Wireless LAN Module
Before installing the WLAN module driver use the On-Screen Menu button 
to power ON (the default setting is OFF) the WLAN module (see “On-Screen
Menu” on page 1 - 18). Make sure you install the drivers in the order indicated in
Table 4 - 1, on page 4 - 3.

802.11b/g Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into your exter-

nal optical device drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the On-Screen Menu
button to toggle power to
the WLAN module, and
check the menu icon to see
if the module is powered on
or not (see Table 1 - 4, on
page 1 - 19).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 6 - 5
Taskbar Menus

Network and 
Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 6 - 6
Connect to a 

Network

Click icon Right-click icon
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 6 - 7
Connecting

Figure 6 - 8
Connection Status
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7. To disconnect from the wireless network you can click the taskbar wireless icon , 
and then select Connect or disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click Disconnect from).

Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unautho-
rized access to your
computer, documents, web-
sites and files etc.

Figure 6 - 9
Disconnecting

Click icon

Right-click icon
Wireless LAN Module 6 - 9
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 6 - 10
Windows Mobility 

Center
6 - 10 Wireless LAN Module
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PC Camera Module
Before installing the PC Camera module driver use the On-Screen Menu button

 to power ON (the default setting is OFF) the PC Camera module (see “On-
Screen Menu” on page 1 - 18). Make sure you install the drivers in the order indicated
in Table 4 - 1, on page 4 - 3.

PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into your exter-

nal optical device drive.
2. Click 2.Install Camera Driver > Yes.
3. Choose the language you prefer and click Next > Next.
4. Click Finish to restart the computer.
5. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the on-screen menu to turn it 
on again).

Camera Button

Press the Camera Button
 to run the BisonCap ap-

plication program.

When the BisonCap appli-
cation is running, press the
Camera Button  to take
a still picture (see also
“Taking Still Pictures” on
page 6 - 16).

Note press the Camera But-
ton  and release it after
you hear the camera shutter
sound. Note that holding the
camera button down will not
take multiple pictures, you
must press and release the
button to take pictures (after
the shutter sound is heard
you will be ready to take fur-
ther pictures).
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs 

> BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
11. Go to the Options menu heading and select Audio Capture Filter to adjust the 

audio options.
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Figure 6 - 11
Audio Setup for PC 

Camera

Right-click
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BisonCap
BisonCap is a video viewer for general purpose video viewing and testing, and for
capturing video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture 
process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 6 - 12) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture (you can view the file using the Windows 
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
“Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 6 - 15 in
order to save file space, and help prevent system problems.

Pre-Allocating File 
Space

You may pre-allocate the
file size (File > Allocate
File Size) for the capture
file in the BisonCap pro-
gram.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 6 -
15.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 6 - 14), limit the file size of the captured video (see “Pre-
Allocating File Space” on page 6 - 14) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
PC Camera Module 6 - 15
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Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In.

Note that the Zoom Mode buttons DO NOT zoom the camera, but do allow you to
zoom in and out of captured pictures (e.g. jpeg files etc.).

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options and select Take Picture.
OR
3. When the camera is on, press the Camera Button  to take a still picture
4. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.

Note press the Camera Button  and release it after you hear the camera shutter
sound (holding the camera button down will only turn BisonCap off).

Figure 6 - 12
Zoom/Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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Fingerprint Reader Module
If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into your exter-

nal optical device drive.
2. Click Option Drivers (button).
3. Click 3.Install Fingerprint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click 3.In-
stall Fingerprint Driver
>Yes.

Click Documentation to
open the folder containing
the manual in.pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or 

double click the taskbar icon  (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to 

accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If 

you have not set a password Protector Suite cannot secure access to your 
computer).

4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get 

help with fingerprint enrollment at any time).

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 6 - 13
Fingerprint 
Enrollment

Tutorial
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6. Click the button above any of the fingers to begin the enrollment process for that 
finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then 

click Save and Continue.
9. Enter a backup password and click Apply.
10. Close the fingerprint status window.

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 6 - 14
Fingerprint Status
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11. Right-click the taskbar icon  and select Start Control Center (and then swipe a 
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and 
access the Help menu etc. You can also run the Control Center etc. from the 
Protector Suite item in the Programs/All Programs menu

12. Click “Help” in Control Center Home to get more information on any topic.
13. You can also run the Tutorial, or Product Tour video to get more information.

14. See “Help & Manual” on page 6 - 17 for further details.
15. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, access the Personal Safe, E-Wallet or 
Strong Password Generator, open the Control Center and access the Help 
menu.

Help

Figure 6 - 15
Control Center & 

Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc. 

Strong Password Generator
Strong Password Generator helps you to create complicated passwords resistant
to dictionary attacks from the Internet.

E-Wallet
The E-Wallet provides biometric security for important personal information such
as credit card details, account numbers etc.

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store
files and folders to be protected by fingerprint protection.

Help 

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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GPS Module
If you have included an Global Positioning System (GPS) receiver module in your
purchase option, you will need to obtain map software suitable for your global loca-
tion. Map software programs are both commercially available and downloadable di-
rectly from the internet.

A Global Positioning System satellite continually transmits high-frequency radio
signals containing the time and location of the satellite in relation to the earth. Your
computer’s GPS receiver obtains information from satellites and calculates your
current position on the planet (to an accuracy of between 3 and 15 meters). Toggle
power to the GPS module using the On-Screen Menu button .

For the best quality signal use the optional antenna and screw the antenna into the
GPS Active Aerial Socket at the rear of the computer (see “System Map: Rear
View” on page 1 - 21).
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Configuring the COM Port for the GPS Module
You need to make sure that the COM port for the GPS module is set to COM 3 at a
4800 baud rate. To do this follow the instructions below:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click Device Manager (icon); Device Manager (icon) is in Hardware and 

Sound (category).
3. Click “+” next to Ports (COM & LPT) if its sub-items are not shown.
4. Double-click Communications Port (COM3). 
5. Click Port Settings (tab) and make sure that the Bits per second rate is set to 

4800 baud.
6. Click OK and close the Device Manager. Figure 6 - 16

COM3 Port Settings 
for the GPS Module
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RFID Reader Module
If you have included the RFID Reader module in your purchase option, you will
need to obtain software suitable for your system. The scanner for the module is lo-
cated at the top of the computer.

• For RFID Reader - Simply hold any RFID enabled card (up to a distance of 
2CM) in front of the scanner to obtain a reading.

RFID Specifications
The RFID reader (maximum usable range of up to 2CM) is compliant with ISO stan-
dard for RFID Air Interface 18000 - Part 3 at 13.56MHz, and with ISO Standard for
Proximity Cards - ISO 15693 Vicinity Cards or Smart Tags (Tag-it HF-I Plus; Tag-
it HF-I Pro/Standard; I-Code2).

See “Configuring the COM Port for the RFID Reader” on page 6 - 25.

Figure 6 - 17
Top View with RFID 

Reader
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Configuring the COM Port for the RFID Reader
You need to make sure that the COM port for the RFID reader is set to COM 1 at a
9600 baud rate. To do this follow the instructions below:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click Device Manager (icon); Device Manager (icon) is in Hardware and 

Sound (category).
3. Click “+” next to Ports (COM & LPT) if its sub-items are not shown.
4. Double-click Communications Port (COM1). 
5. Click Port Settings (tab) and make sure that the Bits per second rate is set to 

9600 baud.
6. Click OK and close the Device Manager. Figure 6 - 18

COM1 Port Settings 
for the RFID Reader
RFID Reader Module 6 - 25
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Chapter 7: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 7 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Indicators (see “LED Indicators” on page 1 - 16) to see 
the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the power button 
to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the on-screen menu to adjust the brightness.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / 
“Remove disks or other media. Press any key to restart”).
7 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “The Power-On Self Test (POST)” on page 5 - 
2).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty
The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your warranty.
Backup and General Maintenance 7 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
7 - 4 Viruses
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Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing (please check with your service representative before undertaking any upgrade procedures to 
find out if this will VOID your warranty).

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When adding a new device always make sure the device is powered on, and in many cases you will need to 
restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have added (latest driver files are usu-
ally available to download from vendor’s websites).
Adding New Hardware/Software 7 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
7 - 6 Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present
and seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Schemes” on page 3 - 4) check its settings. You may also be using a ExpressCard/USB device/
external device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
9).

Power Options have been disabled. Go to the Control Panel in Windows and re-enable the
options.

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn off/remove the
unused device to save power.
Problems and Possible Solutions 7 - 7
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The computer feels too
hot.

Make sure the computer isn’t sitting on a thermal surface. Make sure you’re using the correct
adapter. 

Make sure that your computer is completely powered off before putting it into a travel bag (or any
such container).

Nothing appears on
screen.

The system is in a power saving mode. Press the power button (see “Configuring the Power
Button” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key combinations from the
on-screen menu. If you’re connected to an external monitor, make sure it’s plugged in and
turned on. You should also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the on-screen menu display key button. If an
external monitor is connected, turn it on.

No image appears on the
external monitor I have
plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“Intel Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.

Problem Possible Cause - Solution
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You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “System Power Options” on page 3 - 6. Make sure you have
enabled Hibernate mode from the control panel.

The Wireless LAN,
Bluetooth, GPS, PC
Camera or RFID
modules cannot be
detected.

The modules are off. Check the the on-screen menu to see if the module is on or off.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions for the appropriate module in “Modules” on
page 6 - 1).

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of
this could be serious. If you cannot remember your boot password you must contact your ven-
dor and you may lose all of the information on your hard disk.
Problems and Possible Solutions 7 - 9
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The Hibernate function
has disappeared (in
Windows Vista).

You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1. This
is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack
1. To re-enable Hibernate mode go to the Command Prompt and type the command “powercfg
-h on” (make sure you are logged on as an Administrator):

1. Click Start  (menu button).
2. Type “cmd” in the Start Search box .
3. Double click the Command Prompt  when it appears in the menu.
4. Type “powercfg -h on” in the Command Prompt window.
5. Close the Command Prompt window.
6. The Hibernate function will now be enabled.

Problem Possible Cause - Solution
7 - 10 Problems and Possible Solutions
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Ports and Jacks
View Port/Jack Description

1.Security Lock Slot To prevent possible theft, a Kensington-type lock can be
attached to this slot. Locks can be purchased at any computer
store.

2.DC-In Jack Plug the supplied AC/DC adapter into this jack to power your
computer.

3.USB Port These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1
compliant) are for low-speed peripherals such as keyboards,
mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged
from the computer, without the need to turn the system off (if
the power rating of your USB device is 500mA or above, make
sure you use the power supply which comes with the device).

2 31

Left View
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4.Headphone-Out Jack Headphones or speakers may be connected through this jack.
Note: Set your system’s volume to a reduced level before
connecting to this jack.

5.External Monitor Port This port allows you to connect an external monitor, or Flat
Panel Display, to get dual video or simultaneous display on the
LCD and external monitor/FPD.

6.RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the
LAN port.

7.USB Port These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1
compliant) are for low-speed peripherals such as keyboards,
mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged
from the computer, without the need to turn the system off (if
the power rating of your USB device is 500mA or above, make
sure you use the power supply which comes with the device).

View Port/Jack Description

4 5

Right View

76

Top View
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Appendix B: Intel Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 26.

Intel Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Video Driver
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached 

CD/DVD drive.
2. Click Install Drivers.
3. Click 3.Install Video Driver > Yes.
4. Click Next > Yes > Next > Next.
5. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much system memory
(RAM) as needed to the video system (the video driver must be installed). DVMT
returns whatever memory is no longer needed to the operating system.

DVMT Notes

DVMT is not local video
memory.

DVMT is not user-con-
figurable.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
Intel Video Driver Installation B - 1
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Intel Graphics Properties
More advanced video configuration options are provided by the Intel(R) Graphics
Media Accelerator Driver for ultra mobile.

1. Open the Display Settings control panel (see “Video Features” on page 1 - 26) 
and click Advanced Settings (button).

2. Click the Intel(R)... tab and click Graphics Properties (button).

Taskbar Icon

The Intel GMA control
panel can also be ac-
cessed by clicking the
icon  in the taskbar
and selecting Graphics
Properties from the
menu.

If you cannot see the
tray icon click the “Show
Tray Icon” tickbox in the
Intel(R) Graphics Me-
dia Accelerator for ul-
tra mobile tab.

Figure B - 1
Intel Graphics 

Properties
B - 2 Intel Graphics Properties
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking
the appropriate menu item or button. Click Information (button) to obtain useful in-
formation about the graphics properties of the computer, and see the Support tab in
Information to get weblinks to the latest information on the Intel Website. Help Menus

Right-click on many of
the items in the tabs to
bring up the “What’s
This?” button.

Click the “What’s This?”
button to bring up the
help menu.

Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display options.

Figure B - 2
Intel Graphics Media 
Accelerator Driver 

for ultra mobile
(Control Panel Tabs)
Intel Graphics Properties B - 3
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Display Settings
You can adjust the Color Quality, Screen Resolution and Refresh Rate for any at-
tached display(s) from the Intel(R) GMA Driver for ultra mobile control panel, or
from Display Settings (see page 1 - 26) in Windows.

Note: MID (Mobile Internet Device) is the computer’s LCD display.

Figure B - 3
Display Settings Screen Resolution 

for Games and 
Power DVD

Note that the screen reso-
lution should be set to 800
* 600 if you are playing
games, or are using the
Cyberlink Power DVD
program.
B - 4 Intel Graphics Properties
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Power Settings
Use the Power Settings control to allow the Intel(R) GMA Driver for ultra mo-
bile control panel to adjust the power options when the computer is running on bat-
tery power. To set the power settings:

1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B -

2) and click Display Settings.
3. Click Power Settings (button).
4. You can adjust the slider to achieve a balance between maximum quality, and

maximum battery life.
5. Enabling Intel(R) Automatic Display Brightness will allow the in-built controls to

adjust the display backlight according to the ambient lighting.
6. Enabling Intel(R) Display Power Saving Technology will allow the in-built

controls to adjust the brightness and contrast of the display.

Figure B - 4
Power Settings
Intel Graphics Properties B - 5
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Attaching Other Displays
Besides the built-in LCD, you can also use an external monitor/flat panel display,
connected to the external monitor port at the rear of the computer, as your display
device. The following are the display options:

1. The built-in LCD OR an external monitor/flat panel display connected to the exter-
nal monitor port (Single Display).

2. The built-in LCD AND an external monitor/flat panel display connected to the
external monitor port (Multiple Display).

Configuring Displays from Windows Vista
1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preference, or click
Display Settings to access the control panel.

On-Screen Menu 
Button

You can use the On-
Screen Menu button

 to quickly toggle
through the display op-
tions.

Figure B - 5
Windows Mobility 

Center
B - 6 Attaching Other Displays
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Configuring Displays from Intel® GMA Driver for ultra mobile
1. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B - 

2) and click Display Devices.
2. Click to choose the display option from the Multiple Display menu.
3. Click Apply (and OK to confirm the settings change) and OK (button).

Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display options.

Figure B - 6
 Intel GMA Display 

Devices
Attaching Other Displays B - 7
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Display Modes
Single Display
Only one of your attached displays is used.

Intel(R) Dual Display Clone (mirrored)
This mode will drive multiple displays with the same content. Each device may be
configured independently for different resolutions, refresh rates, color quality etc.
Use this feature to display the screen through a projector for a presentation.

Extended Desktop (extended)
This mode allows a desktop to span multiple displays and acts as a large workspace.
This creates a lot more screen area for display. Use the Display Properties control
panel to drag the monitors to match the physical arrangement you wish to use, or you
may also use the Extended Desktop Settings control panel tab in Graphics Prop-
erties to configure the relative size and position.
B - 8 Display Modes
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To Enable Intel(R) Dual Display Clone
1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B -

2) and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Figure B - 7
 Display Devices & 

Settings
Display Modes B - 9
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To Enable Extended Desktop
1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B -

2) and click Display Devices.
3. Click to choose Extended Desktop (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

 Display Settings 
Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure B - 8
Extended Desktop 

Mode

Click the appropriate moni-
tor icon and drag it to match
the physical arrangement
you wish to use (e.g. the sec-
ondary display may be ex-
tended left/right/above/
below  the primary display).

Click Display Settings to
make any adjustments re-
quired.
B - 10 Display Modes
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Using Windows Vista to Enable Extended Mode
1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 9
Display Properties 

(Extended Desktop)
Display Modes B - 11
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port, and turn it on.
2. Open the Display Settings control panel (see “Video Features” on page 1 - 26).
3. Click the monitor icon (e.g. ), and make sure you have checked “Extend my

Windows desktop onto this monitor.” and click Apply.

Figure B - 10
Display Properties 

(Extended Desktop)

2

Click the appropriate monitor icon
(e.g. ) to be able to select the op-
tion to extend the desktop on to it.

In this example the Primary Display
 is on the left, the Secondary Dis-

play  is on the right.

2

1
2
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

Upgrading the Memory and HDD/SSD

If you want to upgrade your computer by upgrading the system memory or the hard disk drive/solid state drive you will need
to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly
you may damage the mainboard. The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your
warranty.
Specifications C - 1
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Processor Options

Intel® Atom Processor:

512K On-die L2 Cache, 533MHz FSB, 
FC-BGA8 Package
Z520 (1.33GHz), Z530 (1.60GHz), Z540 
(1.86GHz)

Core Logic

Intel® US15W Chipset

LCD Options

8.9” WSVGA (1024 * 600) TFT LED 
Backlight LCD with Touch Panel (Stylus 
Pen & Finger Sensitivity) - Factory 
Option
8.9” WSVGA (1024 * 600) TFT LED 
Backlight LCD with Touch Panel (Stylus 
Pen & Finger Sensitivity) - 
(Sunlight Readable with Brightness at 
least 350 nits) - Factory Option

Memory

One 200 Pin SO-DIMM Socket 
Supporting DDRII (DDR2) 553MHz
Memory Expandable up to 2GB

Video Adapter

Intel® US15W Integrated Video
(Intel® Graphics Media Accelerator 500)

Video Camera

2M Pixel Video Camera Module with USB 
Interface

BIOS

One 8Mb SPI Flash ROM
Phoenix™ BIOS

Drop Protection

G-Sensor Software HDD Drop Protection 
from 40cm when system is powered on
Shock Mounted HDD Drop protection 
from 120cm when system is powered off

Storage

Shock Mounted Hard Disk Drive
SATA 2.5" HDD or SATA Solid State Drive 
(Factory option) Single Level Cell

Audio

Intel® High Definition Audio
Built-In Microphone
2 * Built-In Speakers (1.5W)

Button Keys

5 Directional Key Buttons (Camera, 
Zoom, Page Up, Page Down & Menu)

Interface

Two USB 2.0 Ports
One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One RJ-45 LAN Jack
One Docking Connector
One DC-In Jack
C - 2 Specifications
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Card Reader/ExpressCard

Intel® US15W Integrated 5-in-1 Card 
Reader (SD/ Mini SD/ SDIO/ MMC/ RS 
MMC) Note: Mini SD/ SDIO/ RS MMC 
Cards require a PC adapter
One ExpressCard 34 Slot (see Approved 
ExpressCard list in Table E - 1, on 
page E - 1)

Communication

Built-In 10M/100Mb Base-TX Ethernet LAN
Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module
802.11b/g Wireless LAN Mini-Card 
Module with USB interface
GPS Module (Factory Option)
HF RFID Reader (Factory Option)

Security

Security (Kensington® Type) Lock Slot
Fingerprint ID Reader Module 
BIOS Password

Power Management

Supports Wake on LAN

Power

Full Range AC/DC Adapter 
AC input 100 - 240V, 50 - 60Hz, 
DC Output 19V, 1.58A or 19V, 1.57A (30 
Watts)
Li-Polymer 6600mAH Battery Pack
Energy Star 4.0
Hot Swap Design
Battery Gauge Indicator
Battery Life Around 10 Hours

Operating System

Windows® Vista Home Basic 32bit (with 
Service Pack 1)
Windows® XP (with Service Pack 3)

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

239mm (w) * 190mm (d) * 30mm (h)
Around 1.5 kg With Battery

Indicators

Power/ Suspend/ Battery/ HDD
Battery Gauge

Optional

USB to RS232 Cable
Docking Station (Power Charge and USB * 2)
Input 12V-24Vdc, Output 19V Car 
Adapter, 60W
Shoulder Strap/Carrying Handle/Hand 
Holder
Charger Box
One External 12.7 mm Combo/Super 
Multi USB Optical Device Drive

See Over for Factory Options
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Factory Options

GPS Module
Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module
HF RFID Reader
8.9” WSVGA (1024 * 600) TFT LED 
Backlight LCD with Touch Panel (Stylus 
Pen & Finger Sensitivity)
8.9” WSVGA (1024 * 600) TFT LED 
Backlight LCD with Touch Panel (Stylus 
Pen & Finger Sensitivity) - 
(Sunlight Readable with Brightness at 
least 350 nits)
C - 4 Specifications
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Appendix D: Windows XP Information
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows XP OS.
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Tablet Notebook Input
Use the stylus pen provided to interact with the computer in the same way you would use the mouse (tap twice
to double-click and keep the pen in contact with the screen to right-click). Before using the stylus pen you should
calibrate the touch screen.

Calibrating the Touch Panel
1. Double-click the Touch tool utility icon  on the desktop OR from the Touch Package folder in the Programs/

All Programs group (the driver must be installed).
2. Click General.
3. Click 9 pts Linearity (if you would prefer to calibrate more accurately, or are having distortion/tracking 

problems, then click Advance and choose either 25 pts Linearity).

Figure  D - 1 - Touch Package (General & Advance)
D - 2 Tablet Notebook Input
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4. Use the stylus pen to touch the blinking symbol until symbol changes color (maintain contact until the symbol stops blinking) 
and you will be prompted to lift up the pen.

5. Repeat the process for all the remaining screen points.
6. Click Free Draw (button) to test the calibration.
7. Use the Mouse Emulation and Sound control panels to further adjust the settings to your preference.

Figure  D - 2 - Screen Calibration

Touch Panel Input 
Device

Do not use any sharp or
pointed objects as your
input device e.g. the end
of a pen or pencil. You
should only use the pro-
vided stylus pen (PDA
type) as your input de-
vice. Be very careful not
to press too hard with the
stylus pen when using it
as the input device. 

Screen Distortion

If you experience any line
distortion, or tracking in-
accuracy, recalibrate the
touch screen using 25pts
of calibration (click the
Advance item in the
Touch package and
click 25pts Linearity).
Tablet Notebook Input D - 3
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On-Screen Menu
Pressing the Menu button (or double-click the Pop Menu icon  in the taskbar) on the computer will bring up
the on-screen menu (make sure you install the pop menu driver - see “Pop Menu Utility” on page D - 35). Use
the stylus pen to touch any of the buttons to activate the control. Press the Menu button (or double-click the Pop
Menu icon  in the taskbar) to quit the menu. Use the stylus pen to tap the appropriate on-screen button to
adjust the setting and the button will display the current status.

Figure D - 3 - On-Screen Menu

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard air-
craft is usually prohibited. Make
sure the module(s) are OFF if you
are using the computer aboard air-
craft.

Use the On-Screen Menu button
to toggle power to any Wireless/
Bluetooth/GPS module, and check
the menu icon to see if the module
is powered on or not.
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Table D - 1 - On-Screen Menu Buttons

Function On-Screen Button Function On-Screen Button

Brightness 
Decrease/Increase

Bluetooth Module 
Power Toggle

Volume Decrease/
Increase

PC Camera Module 
Power Toggle

Mute Toggle
G-Sensor 

Protection Mode 
Toggle

Display Toggle GPS Module Power 
Toggle

Display Battery 
Level

RFID Module 
Power Toggle

WLAN Module 
Power Toggle

Note: Any modules not included in your purchase configuration will appear grayed out when the key combination is pressed.

Note: Use the stylus pen to tap the appropriate on-screen button to adjust the setting.

Note: The default setting for the Wireless LAN and PC Camera modules is OFF.
On-Screen Menu D - 5
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G-Sensor - Hard Disk Drive Protection
The built-in G-Sensor gives protection to the system and hard disk (the G-Sensor does not function with Solid
State Drives) in the event that the computer is accidentally dropped when the system is powered on (40cm drop
approved when the system is powered on and 120cm drop approved when the system is powered off). Press
the Menu button (or double-click the Pop Menu icon  in the taskbar) to bring up the on-screen menu and use
the stylus pen to toggle the G-Sensor mode ON  or Off . 

If the system is dropped, and the G-Sensor is on, the system will briefly pause (for about 3 seconds) to protect
the hard disk and will display an on-screen message and an audible warning) to inform that the hard disk is pro-
tected. Allow the system about 3 seconds to recover before using it again.

Figure D - 4 - HDD Protected Message
Set the G-Sensor On or Off in accordance with the manner the computer is being used. If the computer is sitting
on the desktop (or if you find the G-Sensor is too sensitive), then the G-Sensor can be turned Off. The G-Sensor
will be automatically activated to offer protection when the computer enters Sleep or Hibernate modes (even if
turned off).
D - 6 On-Screen Menu
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

Figure D - 5 - Start Menu & Control Panel

Click here to toggle Category View
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Audio Features
You can configure the audio options on your computer from the Sounds and Audio Devices  Windows con-
trol panel, or from the Realtek HD Audio Manager  icon in the taskbar/control panel (this will bring up the
Realtek Audio Configuration menus). The volume may be adjusted by means of the On-Screen Menu buttons
or the volume icon in the taskbar (see below).

Figure  D - 6 - Realtek Audio Configuration Menus

Sound Volume Adjustment

How high the sound volume can be
set depends on the setting of the vol-
ume control within Windows (and the
volume control function keys on the
computer). Click the Volume icon on
the taskbar to check the setting.
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Video Features
You can switch display devices, and configure display options, from the Display Properties control panel in Win-
dows as long as the appropriate Intel video driver is installed.

To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution  (Figure D - 7 on page D - 10).
5. Click the arrow, and scroll to the preferred setting in Color quality (Figure D - 7 on page D - 10).
6. Click Advanced (button)  (Figure D - 7 on page D - 10) to bring up the Advanced properties tabs.
7. Click Intel(R) Graphics Media Accelerator Driver for ultra mobile (tab), and click Graphics Properties (button) to make 

any video adjustments you require.
8. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click 

Settings (tab) and adjust as above.
9. You can also access Intel(R) GMA Driver for ultra mobile from the taskbar icon  menu.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much system memory (RAM) as needed to the video
system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the op-
erating system.

1
2

3
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Display & Graphics Properties
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external
Flat Panel Display connected to the external monitor port as your display device.Taskbar Icon

You can also access the
controller properties
from the taskbar. Click
on the icon to bring up
the menu and scroll to
Graphics Properties.

If you cannot see the
tray icon go to the In-
tel(R) Graphics Media
Accelerator Driver for
ultra mobile tab and
click the “Show Tray
Icon” tickbox. Alterna-
tively right-click the
desktop and select
Graphics Options >
Tray Icon > Enable.

Figure  D - 7
Display & Graphics 

Properties

1 2

3
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking the
appropriate menu item or button.

Help Menus

Right-click on many of
the items in the tabs to
bring up the “What’s
This?” button.

Click the “What’s This?”
button to bring up the
help menu.

Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display options.

Figure  D - 8
Intel Graphics Media 
Accelerator Driver 

for mobile
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Attaching Other Displays
Besides the built-in LCD, you can also use an external monitor/flat panel display as a display device. The fol-
lowing are the display options:

1. The built-in LCD OR an external monitor/flat panel display connected to the external monitor port (Single Display).
2. The built-in LCD AND an external monitor/flat panel display connected to the external monitor port (Multiple Display).

If you want use an external display follow these instructions:
1. Attach your external monitor to the external monitor port and turn it on.
2. Open the Intel(R) GMA Driver for ultra mobile control panel.
3. Click to choose the display option from the Multiple or Single Display menu.
4. Click Apply (and OK to confirm the settings change) and OK (button).

Figure  D - 9 - Display Devices

Screen Resolution for 
Games and Power DVD

Note that the screen resolu-
tion should be set to 800 *
600 if you are playing games,
or are using the Cyberlink
Power DVD program.

Intel Display Note

Note that the notebook is the de-
fault Primary display device and
may not be changed.

Note: MID (Mobile Internet Device)
is the computer’s LCD display.
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Display Modes
Single Display
Only one of your attached displays is used.

Intel(R) Dual Display Clone
This mode will drive multiple displays with the same content. Each device may be
configured independently for different resolutions, refresh rates, color quality etc.
Use this feature to display the screen through a projector for a presentation.

Extended Desktop
This mode allows a desktop to span multiple displays and acts as a large workspace.
This creates a lot more screen area for display. Use Display Devices (tab) to drag the
monitors to match the physical arrangement you wish to use, or you may use Win-
dows Display Properties (control panel) to configure the relative size and position.

Screen Rotation
Use the screen rotation control from the Intel(R) GMA Driver for ultra mobile to
rotate the screen to a portrait/landscape orientation (recalibrate the touch screen after
orientation).

On-Screen Menu 
Button

You can use the On-
Screen Menu button

 to quickly toggle
through the display op-
tions.
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To Enable Intel(R) Dual Display Clone Mode
1. Attach your external display to the external monitor port and turn it on.
2. Open the Intel(R) GMA Driver for ultra mobile control panel.
3. Click to choose Intel(R) Dual Display Clone from Display Devices (tab).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Figure  D - 10 - Display Devices (Dual Display Clone) & Settings
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To Enable Extended Desktop Mode:
1. Attach your external monitor to the external monitor port and turn it on.
2. Open the Intel(R) GMA Driver for ultra mobile control panel.
3. Click to choose Extended Desktop from Display Devices (tab).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Figure  D - 11 - Display Devices (Extended Desktop)

You can also enable the Extended Desktop mode from Windows Display Properties (see page D - 16).

Click the appropriate
monitor icon and drag
it to match the physical
arrangement you wish
to use (e.g. the second-
ary display may be ex-
tended left/right/above/
below  the primary dis-
play).

Click Display Settings
to make any adjust-
ments required.

 Display Settings 
Extended Desktop 

You can have different Colors,
Screen Area and Monitor Re-
fresh Rates for each display
device provided your monitor
can support them.

You can drag the monitor icons
to match the physical layout of
your displays. Icons and pro-
grams may also be dragged
between the displays.
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To Enable Extended Desktop (Display Properties)
1. Attach your external monitor to the external monitor port and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose 

Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. ), and make sure you have checked “Extend my Windows desktop onto this monitor.” and 

click Apply.

Figure  D - 12 - Display Properties (Extended Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2

 Display Settings Extended 
Desktop 

Use the control panel to drag the
monitors to match the physical
arrangement you wish to use. 

You can drag any icons or win-
dows across to either display
desktop, which makes it possible
to have one program visible in
one of the displays, and a differ-
ent program visible in the other
display.
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Power Management Features
To conserve power, especially when using the battery, your computer uses the ACPI
power management system. Power management conserves power by controlling in-
dividual components of the computer (the monitor and hard disk drive) or the whole
system.

The Power Options control panel icon in Windows allows you to configure power
management features for your computer. You may conserve power through individ-
ual components such as the monitor or hard disk, or you may use either Stand by or
Hibernate mode to conserve power throughout the system.

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving techniques
and gives the operating system (OS) direct control over the power and thermal states
of devices and processors. For example, it enables the OS to set devices into low-
power states based on user settings and information from applications. ACPI is fully
supported in Windows XP.

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage
the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Press the power button to turn the computer “on”.
4. Remove the Stylus pen to use as your input device.
5. The LED indicators show the power and battery status of the computer.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable.
Battery life varies depending on the applications and the configuration you're using. To increase battery life,
let the battery discharge completely before recharging (see “How do I completely discharge the battery?”
on page D - 28).
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on press the power button
and release it.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key
button when you press and release it in less than 4 seconds (pressing the power but-
ton without releasing it for longer than this will force the computer to shut down).
Use Power Options (Hardware and Sound menu) control panel in Windows Vista
to configure this feature.

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Turn Off Computer
command from the Start
menu in Windows. This
will help prevent hard
disk or system prob-
lems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination on an attached keyboard
doesn’t work, press and hold the power button for 4 seconds, or longer, to force the system
to turn itself off.

Power Button as Stand by or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s
“Power Options” control panel to set the power button to send the system into Stand by or
Hibernate mode.
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Power Schemes
You can set your computer to conserve power through individual components by
means of Power Schemes. You can also adjust the settings for each scheme to set
the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The
schemes may also be set to set a specified time for the system to enter Stand by or
Hibernate modes (see “System Power Options” on page D - 22).

Resuming 
Operation

Press a key on an at-
tached keyboard, or
move an attached
mouse/TouchPad to re-
sume from Monitor or
Hard Disk Stand by.

Figure  D - 13
Power Schemes
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Each Windows Power Scheme will also adjust the processor performance of your machine in order to save pow-
er. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery
power).

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC
power source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall per-
formance of the computer in order to save power) for maximum power saving when the computer is battery (DC
power) powered. Windows will use Portable/Laptop as the default scheme.
Power Schemes D - 21
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System Power Options
You can use the system power options to stop the computer’s operation and restart where you left off. This sys-
tem features Stand by and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking
the option in the Hibernate tab in the Power Options control panel - see “Hibernate” on page D - 23).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to
turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop)
without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs. 

Stand by Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hi-
bernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode.
D - 22 System Power Options
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Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full
operation. During Stand by the hard disk is turned off, and the CPU is made to idle
at its slowest speed. All open applications are retained in memory. When you are not
using your computer for a certain length of time, which you specify in the operating
system, it will enter Stand by mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD be-
fore it turns the system off. Although it saves the most power it takes the longest time
to return to full operation. You can set your computer to automatically enter Hiber-
nate mode when the battery power is almost depleted. You will need to enable Hi-
bernate mode from the Hibernate tab in the Power Options control panel. The
system will resume from Hibernate mode by pressing the power button to pow-
er the system on.

System Resume

The system can resume
from Stand by mode by:

• Pressing the power
button.

• Pressing the Sleep/
Resume key combi-
nation on an attached
keyboard (if applica-
ble).

Figure  D - 14
Enable Hibernation
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Configuring the Power Button
The power button may be set to send the computer in to either Stand by or Hiber-
nate mode. In Stand by mode, the LED  will blink green. In Hibernate mode
the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving
mode set to save power through individual components (e.g. hard disk, screen), the
LED will remain green.

Figure  D - 15
Power Options

(Advanced - Power 
Buttons)

(Sleep) Button
Power Button Sleep/Resume
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page D - 28 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs
you are running, and peripheral devices attached. Power Options (you may set low
battery Alarms and actions, and check the Power Meter from the Power Options
control panel), and settings in the OS will help prolong the battery life if configured
appropriately.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure  D - 16
Power Options 
(Alarm & Power 

Meter)
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Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

If you need to remove the battery for any reason, see “Removing the Battery” on page D - 30.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 16 for information on the battery charge status, and to “Battery Information” on page D - 25
for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power

To conserve battery power:

Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by
the AC/DC adapter.

Close communication applications when they are not being used.

Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).

Disconnect any unnecessary external devices.
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Battery Guidelines
The following can also apply to any backup batteries you may have.
• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Before removing the battery for storage charge it to 60% - 70%.
• Check stored batteries at least every 3 months and charge them to 60% - 70%.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer by yourself even when you see a message that indicates the bat-
tery is critically low, just let the computer use up all of the battery power and shut
down on its own. Disable the Power Options functions in the Control Panel, espe-
cially any Alarms (unclick the tickboxes - see page D - 25) and Schemes (change
all the settings to Never - see page D - 20). As the battery nears the end of its life save
and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

Battery Gauge
The battery gauge at the rear of the computer provides a clear indication of remaining
battery life. Firmly press the PUSH CHECK button and the Led will show the current
battery level.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
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Battery Indicators
On-screen indicators will display the battery status if the battery level button  is pressed or the AC/DC
adapter is not connected.

Table D - 2 - On-Screen Battery Indicators

Action Icon Description

The on-screen 
battery level  
button is pressed.

Main Battery Level Indicator

Bridge Battery Level Indicator

AC/DC Adapter 
Connection 
Removed

Main Battery Level is Under 3%
Plug-in the AC/DC Adapter

Main Battery Level is Under 3%
Change Battery
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Removing the Battery
If you need to remove the battery follow the procedure below.
1. Turn the computer off (unless you are hot swapping the battery), and turn it over.
2. Remove screws at points  - .
3. Remove the battery cover . 
4. Grip the tab  and lift the battery out in the direction of the arrow .

Figure D - 17 - Battery Removal

1 4
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2 3
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Hot-Swapping the Battery
If you have more than one battery included in your purchase option you can swap the battery while the system
is running. 

1. Check the level of the backup battery from the on-screen menu.
2. Press the battery level button  to display the indicator:

Figure D - 18 - Battery Level Indicator
3. The lower indicator will display the bridge battery level and the upper indicator displays the main battery level.
4. If the bridge battery level indicated “Ready” you can swap batteries.
5. Remove the AC/DC adapter cable from the DC-In jack (if applicable) and an on-screen icon will indicate the 

main battery status if less than a 3% charge remains.

Figure D - 19 - Bridge Battery Ready Indicators
6. You can then remove the battery as per the instructions in “Removing the Battery” on page D - 30.
7. When the battery is removed a beep will indicate that the system is running on bridge battery power (you have 

up to 3 minutes maximum to swap the battery depending upon applications being used).
8. When a new sufficiently charged battery is inserted the beep will stop.

Main Battery Level

Bridge Battery Level

Battery Less than 3% Charge - Plug-in Adapter to ChargeBattery Less than 3% Charge - Change Battery
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Driver Installation
You will need to attach a CD/DVD drive to the com-
puter in order to access the drivers on the Device Driv-
ers & Utilities + User’s Manual disc. This contains
the drivers and utilities necessary for the proper oper-
ation of the computer.

Click Install Drivers/Option Drivers (button) and then
click the appropriate driver name from the Drivers In-
staller menu. Follow the instructions to install the driver.

Figure  D - 20 - Drivers Installer Screen 1

1. Check the driver installation order from Table D - 3 (the 
drivers must be installed in this order) which is the 
same as that listed in the Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become greyed out (if you 
need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following pages.

Figure  D - 21 - Drivers Installer Screen 2
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Table D - 3 - Driver Installation

WinXP SP3 Driver Page #

Chipset Page D - 34

Video Page D - 34

Audio Page D - 34

LAN Page D - 35

Touch Panel Application Page D - 35

Pop Menu Utility Page D - 35

Wireless LAN Module Page D - 42

PC Camera Module Page D - 44

Fingerprint Reader Module Page D - 49

Windows XP Service Pack 3

Make sure you install Windows XP Service Pack 3 (or a
Windows XP version which includes Service Pack 3) be-
fore installing any drivers.

Driver Installation General Guidelines

The driver installation procedures outlined in this
Chapter are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Add/Remove Programs item. If you see the
individual driver listed (if not see below), uninstall it,
following the on screen prompts (it may be necessary to
restart the computer). Go to the appropriate section of the
manual to complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Programs
item:
1. Click Start (menu), point to Settings and click Control 

Panel (or click Start > Control Panel). 
2. Double-click System (icon); System (icon) is in 

Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc into the attached CD/DVD drive, click Install Driv-
ers/Option Drivers (button) and then click the appropri-
ate driver name from the Drivers Installer menu.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.
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LAN
1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Touch Panel Application
1. Click 5.Install Touch Panel Driver > Yes.
2. Click Next > Next > Install.
3. Click Finish.
4. Click OK to restart the computer.
5. You will then need to calibrate the touch panel 

(see “Calibrating the Touch Panel” on page D 
- 2).

Pop Menu Utility
1. Click 6.Install POP Menu Utility > Yes. 
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
4. See “On-Screen Menu” on page D - 4 for 

details.

Module Drivers
See the following pages for the driver installation pro-
cedures for any of the optional modules included in
your purchase configuration.

Figure  D - 22 - Optional Drivers
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Bluetooth Module
Note: The operating system is the default setting for
Bluetooth control in Windows XP, and does not re-
quire a driver. See “Bluetooth Module” on page D -
37 for configuration instructions.

Wireless LAN Module
See “Wireless LAN Module” on page D - 42.

PC Camera Module
See “PC Camera Module” on page D - 44.

Fingerprint Reader Module
See “Fingerprint Reader Module” on page D - 49.

Bluetooth & Wireless LAN Modules

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices
aboard aircraft is usually prohibited. Make sure the module(s)
are OFF if you are using the computer aboard aircraft.
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Bluetooth Module
The operating system’s Bluetooth Devices (the Bluetooth module is a Factory Option) control panel is used to
configure the Bluetooth settings in Windows XP, and therefore does not require a driver. Use the On-Screen
Menu button  to power ON the Bluetooth module (see “On-Screen Menu” on page D - 4).

Bluetooth Data Transfer

Note that transferring data between the computer and a
Bluetooth enabled device is supported in one direction
only (simultaneous data transfer is not supported). 

Therefore if you are copying a file from your computer to
a Bluetooth enabled device, you will not be able to copy
a file from the Bluetooth enabled device to your comput-
er until the file transfer process from the computer has
been completed.

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic transmission
devices aboard aircraft is usually prohibited.
Make sure the module(s) are OFF if you are us-
ing the computer aboard aircraft.

Use the On-Screen Menu button to toggle
power to the Bluetooth module, and check the
menu icon to see if the module is powered on
or not (see Table D - 1, on page D - 5).
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Bluetooth Local Area Connection Icon
If you want to display the Local Area Connection icon for the Bluetooth connection
in the taskbar, set it up as follows:

1. Access the Network Connections control panel in Windows (Start > Settings > 
Network Connections OR Start > Connect To > Show all Connections) or by 
clicking the taskbar icon .

2. Right-click the Bluetooth connection icon, and select Properties.
3. Click to put a tick (if none is present) in the “Show icon in the notification area

when connected” box and click OK.
4. Close the control panels and the icon  for the Bluetooth local area connection will

be displayed in the taskbar when connected (see sidebar and overleaf).

Figure D - 23
Local Area 
Connection
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Bluetooth Configuration in Windows XP
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the On-Screen Menu button to toggle power to the Bluetooth module.
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Blue-

tooth Devices (Network and Interned Connections).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the task-
bar, access the Blue-
tooth Devices control
panel. Click Options
(tab), and make sure that
Show Bluetooth icon in
the notification area
check box has a tick in-
side it.

Note that you will need to
check the LED indicator
to see if the module is
powered on or not.

Figure D - 24
Bluetooth Devices & 

Click Icon Menu
Bluetooth Module D - 39



Windows XP Information

D

To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to

this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
4. The Add Bluetooth Device Wizard will appear.
5. Click to select “My device is set up and ready to be found”, and then click Next.

6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.

9. Click Finish.

Figure D - 25
Add Bluetooth 
Device Wizard

Passkey Options

You can allow the sys-
tem to choose a pass-
key for you. You will
then be prompted to en-
ter the generated pass-
key on your Bluetooth
device.

Figure D - 26
Passkey Option
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Turn discovery on check box (Discovery) has a tick 

inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box 

(Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to 
connect.

Bluetooth Module & 
Resuming From 

Sleep Mode

The Bluetooth module’s
default state will be off af-
ter resuming from the
Sleep power-saving
state. Use On-Screen
Menu button to power on
the Bluetooth module af-
ter the computer resumes
from Sleep.

Figure D - 27
Bluetooth Devices 

Options
Bluetooth Module D - 41



Windows XP Information

D

Wireless LAN Module
Before installing the WLAN module driver use the On-Screen Menu button 
to power ON (the default setting is OFF) the WLAN module (see “On-Screen
Menu” on page D - 4). Make sure you install the drivers in the order indicated in
Table D - 3, on page D - 33.

802.11 b/g WLAN Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into your external 

optical device drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.
7. The operating system is the default setting for Wireless LAN control in Win-

dows XP (see overleaf).
8. Access any available wireless networks from Network Connections > 

Wireless Network Connection menu in Windows (or click the icon  in 
the taskbar), and click View Wireless Connections.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the On-Screen Menu
button to toggle power to
the WLAN module, and
check the menu icon to see
if the module is powered on
or not (see Table D - 1, on
page D - 5).
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Network 
Connection

Use the Windows Net-
work Connections con-
trol panel to access
available wireless net-
works (Start > Settings >
Network Connections
or Start > Connect To >
Show all Connections).

Figure  D - 28 
Wireless Network 

Control Panels
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PC Camera Module
Before installing the PC Camera module driver use the On-Screen Menu button

 to power ON (the default setting is OFF) the PC Camera module (see “On-
Screen Menu” on page D - 4). Make sure you install the drivers in the order indicated
in Table D - 3, on page D - 33.

PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into your external 

optical device drive.
2. Click 2.Install Camera Driver > Yes.
3. Choose the language you prefer and click Next > Next.
4. Click Finish to restart the computer.
5. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Programs 
menu (if the hardware is turned off use the on-screen menu to turn it on 
again).

Camera Button

Press the Camera Button
 to run the BisonCap ap-

plication program.

When the BisonCap appli-
cation is running, press the
Camera Button  to take
a still picture (see also
“Taking Still Pictures” on
page D - 48).

Note press the Camera But-
ton  and release it after
you hear the camera shutter
sound. Note that holding the
camera button down will not
take multiple pictures, you
must press and release the
button to take pictures (after
the shutter sound is heard
you will be ready to take fur-
ther pictures).
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PC Camera Audio Setup
To capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds 
& Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).

2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio Input from the Mixer device menu.
5. Make sure the Mic Volume (check box) is checked, then click OK.
6. Boost the volume in the Mic Volume as high as it will go.
7. Close the Recording Control window, and then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio Input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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BisonCap
BisonCap is a video viewer for general purpose video viewing and testing, and cap-
turing video files to.avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture 
process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page D - 45) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File
menu, and set the file name and location before capture (this will help avoid acciden-
tally overwriting files). Set the name and location then click Open, then set the
“Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page D - 47 in
order to save file space, and help prevent system problems.

Pre-Allocating File 
Space

You may pre-allocate
the file size (File > Allo-
cate File Space) for the
capture file in the
BisonCap program.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.

See also “Reducing
Video File Size” on
page D - 47.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check the video file size (right-click the file and select Properties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties) If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows XP system requires a minimum of 1.5GB of free space on the C: drive system partition.
In order to prevent system problems it is recommended that you save the captured video file to a location other
than the C: drive (see “Set Capture File” on page D - 46), limit the file size of the captured video (see “Pre-
Allocating File Space” on page D - 46) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
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Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In.

Figure  D - 29 - Zoom/Setting

Note that the Zoom Mode buttons DO NOT zoom the camera, but do allow you to
zoom in and out of captured pictures (e.g. jpeg files etc.).

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options and select Take Picture.
OR
3. When the camera is on, press the Camera Button  to take a still picture
4. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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Fingerprint Reader Module
If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Pro-
tector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into your exter-

nal optical device drive.
2. Click Option Drivers (button).
3. Click 3.Install Fingerprint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click 3.In-
stall Fingerprint Driver
>Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite QL > User Enrollment, 

or double click the taskbar icon  (click Initialize).
2. On the first run of the program you will be asked to click the button to accept the

license, and then click OK.
3. Click Next (the enrollment method will automatically be configured).
4. If you have not set a Windows password you will be prompted to do so (note: If you

have not set a password Protector Suite QL cannot secure access to your
computer).

5. Click Finish.
6. Click Next.
7. You will then be prompted to enter your Windows password and click Next.
8. Select either to use the fingerprint reader alone for authentication, or choose both

the fingerprint reader and the Windows password, and then click Next.

Figure  D - 30
Multifactor
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9. Click Next > Next (if you have the “Run interactive tutorial” tickbox selected you will run 
through the Fingerprint Tutorial).

10. Click Next for each window of the tutorial (you can click the button to “skip tutorial” at any 
time).

11. Click the button above any of the fingers to begin the enrollment process for that finger.
12. Swipe the finger five times to enroll that finger.
13. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click Next.
14. Click Finish.
15. Click “Help” in the Fingerprint Control Center to get more information on any topic.
16. You can also run the Tutorial, or Introduction (to run the product tour video) to get more 

information.

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure  D - 31
Fingerprint 
Enrollment
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17. Right-click the taskbar icon  to Start Control Center to allow you to Edit
Fingerprints, register applications, manage Password Bank, File Safe and
access the Help menu etc. You can also run the Control Center etc. from the
Protector Suite QL item in the Programs/All Programs menu.

18. See “Help & Manual” on page D - 49 for further details.
19. If you swipe your finger over the reader at any time you can access the Biomenu to

lock the computer, register websites, access the Personal Safe open the
Control Center and access the Help menu.

Figure D - 32
Control Center & 

Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when assigned to a particular fin-
ger. Simply copy the application icon on to one of the registered fingers and ten click OK to close the application
window. Once registered the application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other settings for web sites etc. 

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store files and folders to be pro-
tected by fingerprint protection.

For more information on these and other features simply access “Help” in the Fingerprint Control Center and
select the item from the menu on the left.
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GPS Module
If you have included an Global Positioning System (GPS) receiver module in your purchase option, you will
need to obtain map software suitable for your global location. Map software programs are both commercially
available and downloadable directly from the internet.

A Global Positioning System satellite continually transmits high-frequency radio signals containing the time and
location of the satellite in relation to the earth. Your computer’s GPS receiver obtains information from satellites
and calculates your current position on the planet (to an accuracy of between 3 and 15 meters). Toggle power to
the GPS module using the On-Screen Menu button .

For the best quality signal use the optional antenna and screw the antenna into the GPS Active Aerial Socket at
the rear of the computer (see “System Map: Rear View” on page 1 - 21).
D - 54 GPS Module



Windows XP Information

D

Configuring the COM Port for the GPS Module
You need to make sure that the COM port for the GPS module is set to COM 3 at a
4800 baud rate. To do this follow the instructions below:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button). 
4. Click “+” next to Ports (COM & LPT) if its sub-items are not shown.
5. Double-click Communications Port (COM3). 
6. Click Port Settings (tab) and make sure that the Bits per second rate is set to 4800 baud.
7. Click OK and close the Device Manager.

Figure D - 33
COM3 Port Settings 
for the GPS Module
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RFID Reader Module
If you have included the RFID Reader module in your purchase option, you will need
to obtain software suitable for your system. The scanner for the module is located at
the top of the computer.

•For RFID Reader - Simply hold any RFID enabled card (up to a distance of 2CM) 
in front of the scanner to obtain a reading.

RFID Specifications
The RFID reader (maximum usable range of up to 2CM) is compliant with ISO stan-
dard for RFID Air Interface 18000 - Part 3 at 13.56MHz, and with ISO Standard for
Proximity Cards - ISO 15693 Vicinity Cards or Smart Tags (Tag-it HF-I Plus; Tag-
it HF-I Pro/Standard; I-Code2).

See “Configuring the COM Port for the RFID Reader” on page D - 57

Figure D - 34
Top View with RFID 

Reader Pictured
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Configuring the COM Port for the RFID Reader
You need to make sure that the COM port for the RFID reader is set to COM 1 at a
9600 baud rate. To do this follow the instructions below:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click Device Manager (icon); Device Manager (icon) is in Hardware and Sound 

(category).
3. Click “+” next to Ports (COM & LPT) if its sub-items are not shown.
4. Double-click Communications Port (COM1). 
5. Click Port Settings (tab) and make sure that the Bits per second rate is set to 9600 baud.
6. Click OK and close the Device Manager.

Figure D - 35
COM1 Port Settings 
for the RFID Reader
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Appendix E: ExpressCard 34 Approved List 
The ExpressCards listed in the table below are approved for use with this computer. Please make sure any Ex-
pressCards you use with this computer are included in the list. For further information contact your service cen-
ter.

Table E - 1 - Approved ExpressCards

Model Brand

5-In-1

GIGA-LAN
APIOTEK

Abocom

32G SSD ExpressCard Transcend

16G SSD ExpressCard Transcend

AVerMedia AVerTV DVB-T AVerMedia

Brand Luxe 3.5G ExpressCard Brand Luxe

Abocom Card Reader Abocom

Merlin XU870 3G Card Merlin
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